
BỘ 80 CÂU TRẮC NGHIỆM ÔN TẬP 

TIN HỌC 7 – CÁNH DIỀU (CHỦ ĐỀ A – C – D – F) 

Câu 1. Hành động nào sau đây là an toàn khi sử dụng mạng xã hội? 

A. Chia sẻ mật khẩu 

B. Đăng ảnh nhạy cảm 

C. Kết bạn với người lạ 

D. Cài đặt quyền riêng tư 

Câu 2. Thành phần bắt buộc để tạo tài khoản mạng xã hội là gì? 

A. Ảnh bìa 

B. Email hoặc số điện thoại 

C. Tiểu sử 

D. Avatar 

Câu 3. Hành vi nào vi phạm quyền riêng tư? 

A. Đặt mật khẩu mạnh 

B. Đổi mật khẩu cá nhân 

C. Bật xác thực 2 lớp 

D. Đọc trộm tin nhắn người khác 

Câu 4. Biểu hiện của người sử dụng mạng xã hội thiếu văn hoá là: 

A. Tôn trọng ý kiến người khác 

B. Kiểm chứng thông tin trước khi chia sẻ 

C. Bình luận ác ý, xúc phạm 

D. Sử dụng ngôn ngữ phù hợp 

Câu 5. Dấu hiệu nhận biết tin giả là: 

A. Nguồn uy tín, có kiểm chứng 

B. Thông tin giật gân, gây sốc 

C. Có trích dẫn báo chính thống 

D. Tác giả rõ ràng 

Câu 6. Một trong các lợi ích của cộng đồng mạng là: 

A. Tăng tin giả 

B. Chia sẻ tri thức 

C. Lộ thông tin cá nhân 

D. Gây nghiện thiết bị 

Câu 7. Hành động nào không tử tế với người khác trên mạng? 

A. Không cho mượn tài khoản 

B. Không chia sẻ bí mật cá nhân 

C. Đăng ảnh nhóm có bạn bị nhắm mắt 

D. Trò chuyện thân thiện 

Câu 8. Bạn nhận được tin nhắn lạ yêu cầu cung cấp OTP. Em nên làm gì? 

A. Gửi ngay để hỗ trợ 

B. Chặn và xoá tin nhắn 

C. Đăng tin lên nhóm lớp 



D. Gửi bạn bè xem thử 

Câu 9. Chia sẻ quá nhiều thông tin cá nhân dễ dẫn đến: 

A. Tăng kết bạn 

B. Mất an toàn thông tin 

C. Tạo uy tín 

D. Dùng mạng xã hội tốt hơn 

Câu 10. Khi chuyển tiếp tin nhắn bạn tỏ tình cho cả lớp xem, em đã: 

A. Tôn trọng bạn 

B. Đùa vui vô hại 

C. Không tôn trọng người khác 

D. Giúp bạn nổi tiếng 

Câu 11. Thiết bị nào sau đây thuộc thiết bị lưu trữ? 

A. Chuột 

B. Bàn phím 

C. USB 

D. Màn hình 

Câu 12. Thói quen nào giúp sử dụng máy tính an toàn? 

A. Cài phần mềm lạ 

B. Không cập nhật hệ điều hành 

C. Sử dụng mật khẩu mạnh 

D. Nhấn vào mọi đường dẫn nhận được 

Câu 13. Mật khẩu mạnh là mật khẩu: 

A. Ngắn, dễ nhớ 

B. Toàn chữ thường 

C. Kết hợp chữ, số, ký tự đặc biệt 

D. Là tên người dùng 

Câu 14. Hành động nào giúp chống virus máy tính? 

A. Tắt tường lửa 

B. Không dùng phần mềm diệt virus 

C. Tải phần mềm từ nguồn không rõ 

D. Cập nhật phần mềm diệt virus 

Câu 15. Biện pháp tránh mất dữ liệu quan trọng là: 

A. Lưu tất cả vào 1 thư mục 

B. Sao lưu định kỳ 

C. Không cần lưu 

D. Chỉ lưu trên USB 

Câu 16. Khi máy tính xuất hiện cảnh báo virus, em cần: 

A. Bỏ qua 

B. Tắt máy ngay lập tức 

C. Chạy phần mềm diệt virus 

D. Gỡ toàn bộ phần mềm 

Câu 17. Ứng xử an toàn trên mạng gồm: 



A. Không chia sẻ thông tin cá nhân 

B. Nhấp mọi link được gửi 

C. Đăng ảnh nhạy cảm 

D. Dùng chung mật khẩu 

Câu 18. Thiết bị nào không phải thiết bị vào? 

A. Bàn phím 

B. Máy quét 

C. Chuột 

D. Máy in 

Câu 19. Khi chơi game quá lâu dẫn đến: 

A. Tăng tập trung 

B. Giảm kết nối bạn bè 

C. Mệt mỏi, giảm học tập 

D. Tăng tốc độ gõ phím 

Câu 20. Biện pháp bảo vệ mắt khi dùng máy tính: 

A. Ngồi quá gần màn hình 

B. Mắt không rời màn hình 

C. Ánh sáng phòng hợp lý 

D. Dùng máy 5–6 giờ liên tục 

Câu 21. Thư mục dùng để: 

A. Lưu và chứa tệp 

B. Nghe nhạc 

C. Xem video 

D. Cài đặt phần mềm 

Câu 22. Phần mở rộng của tệp văn bản Word là: 

A. .pptx 

B. .docx 

C. .xlsx 

D. .exe 

Câu 23. Để đổi tên tệp, thao tác đúng là: 

A. Nháy đúp tệp 

B. Nháy phải chọn Rename 

C. Kéo tệp sang vị trí khác 

D. Mở tệp rồi lưu lại 

Câu 24. Trong cửa sổ File Explorer, ô tìm kiếm có chức năng: 

A. Sắp xếp tệp 

B. Xóa tệp 

C. Tìm tệp/thư mục 

D. Sao chép tệp 

Câu 25. Biểu tượng thùng rác Recycle Bin dùng để: 

A. Xoá vĩnh viễn 

B. Chứa tệp tạm xoá 



C. Mở phần mềm đồ họa 

D. Khôi phục hệ thống 

Câu 26. Phím tắt để sao chép tệp là: 

A. Ctrl + X 

B. Ctrl + C 

C. Ctrl + V 

D. Ctrl + Z 

Câu 27. Để tìm nhanh tệp Word, gõ từ khóa nào hiệu quả nhất? 

A. .exe 

B. .jpg 

C. .docx 

D. .mp3 

Câu 28. Tệp không thể mở bằng Word? 

A. .docx 

B. .pdf 

C. .txt 

D. .mp4 

Câu 29. Khi tổ chức thư mục hợp lý sẽ giúp: 

A. Giảm tốc độ máy 

B. Khó tìm tệp 

C. Tìm kiếm nhanh, dễ quản lý 

D. Tăng virus 

Câu 30. Phần mềm hỗ trợ nén và giải nén tệp: 

A. WinRAR 

B. Paint 

C. Excel 

D. Word 

Câu 31. Đa phương tiện (multimedia) là: 

A. Chỉ âm thanh 

B. Chỉ văn bản 

C. Kết hợp văn bản, hình ảnh, âm thanh, video 

D. Chỉ video 

Câu 32. Trong bài trình chiếu, Slide là: 

A. Một trang trình chiếu 

B. Một đoạn video 

C. Một tệp văn bản 

D. Một âm thanh 

Câu 33. Phần mềm thường dùng tạo bài trình chiếu: 

A. Excel 

B. PowerPoint 

C. Paint 

D. Word 



Câu 34. Định dạng âm thanh: 

A. .wav 

B. .docx 

C. .pptx 

D. .xlsx 

Câu 35. Để chèn hình ảnh vào PowerPoint, chọn: 

A. Insert → Picture 

B. File → Save 

C. View → Zoom 

D. Home → Cut 

Câu 36. Một bài trình chiếu tốt cần: 

A. Chữ quá nhỏ 

B. Nhiều màu lòe loẹt 

C. Nội dung rõ ràng, hình ảnh phù hợp 

D. Nhồi nhét nhiều chữ 

Câu 37. Hiệu ứng chuyển slide gọi là: 

A. Transition 

B. Animation 

C. Timeline 

D. Filter 

Câu 38. Tệp trình chiếu có phần mở rộng: 

A. .pptx 

B. .mp3 

C. .jpg 

D. .zip 

Câu 39. Để trình chiếu từ slide hiện tại, dùng phím: 

A. F1 

B. F5 

C. Ctrl + P 

D. Esc 

Câu 40. Khi chèn video vào slide, em cần: 

A. Đặt video gần file PowerPoint 

B. Xoá file video 

C. Không cần lưu video 

D. Đặt video trong thùng rác 

Câu 41. Thiết bị nào sau đây thuộc nhóm thiết bị vào? 

   A. Chuột   B. Máy in   C. Loa   D. Máy chiếu 

Câu 42. Webcam là thiết bị… 

A. Thiết bị vào   B. Thiết bị ra  C. Vừa vào vừa ra  D. Lưu trữ 

Câu 43. USB thuộc loại thiết bị nào? 

A. Thiết bị vào  B. Thiết bị lưu trữ  C. Thiết bị ra  D. Cả A và B 



Câu 44 : Hành vi nào sau đây là hành vi nghiện internet : 

A. Tự quy định mỗi ngày chơi game 1 tiếng  B. Thức thâu đêm để chơi game trực tuyến. 

C. Không dành thời gian nhiều cho mạng xã hội  D. Rủ bạn chơi game liên tục nhiều 

ngày 

Câu 45 : Em mới quen được một bạn trên mạng, bạn đó muốn nhờ em chia sẻ giúp 

bạn một video bạo lực. Em sẽ : 

A. Chia sẻ giúp bạn. B. Không chia sẻ và nói với bạn không nên làm vậy. 

C. Chỉ chia sẻ trong những nhóm kín. D. Không chia sẻ công khai nhưng sẽ gửi cho từng bạn 

bè 

Câu 46. Hệ điều hành có chức năng chính là: 

A. Lưu trữ dữ liệu   B. Quản lý phần cứng và phần mềm 

C. Kết nối Internet   D. Gõ văn bản 

Câu 47. Ví dụ của hệ điều hành là: 

A. Excel   B. Google Chrome  C. Windows  D. Word 

Câu 48 :Trong giờ tự học, cả lớp đang trật tự học bài thì có tiếng điện thoại reo. 

Bạn Minh nghe điện thoại và nói to mừng rỡ “Tiến đến rồi à ! Tớ ra ngay đây”. 

Chọn câu em cho là phù hợp: 

A.Đó là không tôn trọng người khác; B.Thông cảm được, “bạn ấy mừng quá ấy mà”; 

C.Đấy là quyền tự do cá nhân;  D.Đó là một việc bình thường trong lớp. 

Câu49 : Hành động nào sẽ làm em dễ gặp thông tin xấu trên mạng? 

A. Chỉ truy cập vào các trang thông tin có nội dung phù hợp với lứa tuổi. 

B. Không nháy chuột vào các thông tin quảng cáo gây tò mò, giật gân, dụ dỗ kiếm tiền. 

C. Xác định rõ mục tiêu mỗi lần vào mạng để không sa đà vào các thông tin không liên 

quan. 

D. Bạn gửi đường link qua tin nhắn Facebook và kêu em giúp like dùm, em làm theo. 

Câu 50 : Những phương án nào không là tác hại của bệnh nghiện Internet? 

A. Sức khoẻ thể chất và sức khoẻ tâm thần giảm sút. 

B. Thiếu kết nối với thế giới thực, mất dần các mối quan hệ bạn bè, người thân. 

C. Dễ bị lôi kéo vào các việc xấu trên mạng. 

D. Dùng facebook học nhóm và kết quả học tập có tiến bộ 



Câu 51: Cách tốt nhất em nên làm khi bị ai đó bắt nạt trên mạng là gì? 

A. Nói lời xúc phạm người đó. 

B. Cố gắng quên đi và tiếp tục chịu đựng. 

C. Nhờ bố mẹ, thầy cô giáo giúp đỡ, tư vấn. 

D. Đe dọa người bắt nạt mình. 

Câu 52 :Theo em những việc làm nào dưới đây là không “Giữ gìn hình ảnh bản 

thân trên không gian mạng” khi sử dụng mạng xã hội:  

A.Kết nhiều bạn trên mạng    B.Nói tục, chửi thề;  

C.Dùng hình đại diện là ảnh của người khác D.Dùng hỉnh ảnh thực của mình làm hình đại diện 

Câu 53 :Mục đích của mạng xã hội là gì? 

A. Chia sẻ, học tập, B. Chia sẻ.     C. học tập, tiếp thị.    D. Chia sẻ, học tập, tương tác, tiếp thị. 

Câu 54: Trong các website dưới đây, website nào là mạng xã hội? 

A. Vnngaynay.vn B. https:// zalo.me C. https:// tienphong.vn D. https:// thieunien.vn 

Câu 55. Để chọn nhiều tệp liền kề, giữ phím: 

A. Shift  B. Alt   C. Ctrl  D. Tab 

Câu 56: Những hành động nào dưới đây là không tử tế với người khác trên không 

gian mạng:  

A. Không cho bạn dùng chung tài khoản mạng;   

 B. Không   nói hết cho bạn những “bí mật” của mình; 

C.Đăng ảnh nhóm trong đó có bạn đang nhắm mắt;   

D. Quý bạn trên mạng hơn người thân trong gia đình 

Câu 57: Em phát hiện ra có người giả mạo tài khoản Facebook của em để đăng 

những video đồi trụy, bạo lực, em sẽ: 

A. Kệ vì đó chỉ là kẻ mạo danh.   

B. Coi như không biết. 

C. Đăng lên mạng để thanh minh đó không phải là mình.  

D. Cảnh báo người thân, bạn bè để tránh bị lừa đảo, sau đó báo cáo tài khoản mạo danh để 

Facebook khóa tài khoản mạo danh. 



Câu 58. Thành phần bắt buộc để có tài khoản MXH: 

A. Avatar     B. Email hoặc số điện thoại 

C. Tiểu sử    D. Ảnh bìa 

Câu 59. Hành động nào an toàn khi dùng MXH? 

A. Chia sẻ mật khẩu    B. Kết bạn người lạ 

C. Cài đặt quyền riêng tư   D. Đăng ảnh nhạy cảm 

Câu 60: Khi tham gia mạng xã hội em cần chú ý: 

A. Emthích nói gì em nói vì trên mạng “lời nói gió bay” 

B. Luôn xuyên tạc thông tin và đưa lên mạng để câu like 

C.Lên mạng chủi để nhiều người biết người đó xấu 

D.Giữ gìn hình ảnh bản thân, luôn tử tế với người khác 

Câu 61: Các câu nói về mạng xã hội sau đây sai? 

A. Mạng xã hội giúp mọi người tương tác với nhau mà không cần gặp mặt.  

B. Tất cả các website đều là mạng xã hội.  

C. Người xấu có thể đưa tin giả lên mạng xã hội. Vì vậy, chỉ nên trò chuyện với người 

mình quen biết.  

D. Số lượng người tham gia kết bạn trên mạng xã hội được giới hạn. 

Câu 62: Phím nào sau đây cho phép xóa tệp (thư mục)? 

A Delete   B.Backspace  C. Caplock  D.Tab 

Câu 63: Để sử dụng mạng xã hội Facebook, cần tạo tài khoản cá nhân thông qua: 

A. Số điện thoại   

B. Địa chỉ email 

C. Số điện thoại hoặc Email 

D. Số điện thoại, zalo 

Câu 64: Em có thể kết hợp phím nào sau đây để có thể chọn nhiều tệp, thư mục cùng 

1 lúc? 

A. Alt   B.Shift   C.Tab   D.Ctrl  

Câu 65: Hành vi nào VI PHẠM quyền riêng tư? 

A. Đổi mật khẩu cá nhân 

B. Đọc trộm tin nhắn người khác 



C. Bật 2 lớp bảo mật 

D. Đặt mật khẩu mạnh 

Câu 66: Để đổi tên tệp hay tên thư mục em cần: 

A. Click chuột trái chọn Name   B.Click chuột phải chọn Name 

C.Click chuột trái chọn Rename  D.Click chuột phải chọn Rename 

Câu 67: Đâu không phải là lời khuyên ứng xử có văn hóa khi giao tiếp qua mạng 

A. Tôn trọng nhưng người xung quanh        B.Giữ gìn hình ảnh bản thân trên không gian mạng 

C.Tôn trọng quyền riêng tư của người khác  D.Hãy ngủ dậy sớm 

Câu 68: Nơi cho phép người sử dụng tạo hồ sơ cá nhân kết nối bạn bè. Người sử 

dụng có thể chia sẻ suy nghĩ, và ý kiến cá nhân cũng như hình ảnh âm nhạc, video? 

A. Facebook    B. Windows 10  C. Scratch   D. Mario 

Câu 69: Trong lớp em có bạn nhắn tin ngỏ ý quý em, em chuyển tiếp tin đó cho 

nhiều bạn khác trong lớp, em cảm thấy như vậy là em đã:  

A. Không tôn trọng người khác  B.Để mọi người trong lớp biết bạn quý mình 

C.Tỏ thái độ khinh bỉ bạn ấy  D.Chỉ chuyển tin nhắn nhằm mục đích đùa vui 

Câu 70: Để khôi phục lại thư mục BÀI_TẬP ở ổ đĩa D bị xóa, em thực hiện như nào? 

A.Recycle Bin  Click chuột phải tệp BÀI_TẬP  Cut 

B.Recycle Bin  Click chuột phải tệp BÀI_TẬP  Delete 

C.Recycle Bin  Click chuột phải tệp BÀI_TẬP  Properties 

D.Recycle Bin  Click chuột phải tệp BÀI_TẬP  Restore 

Câu 71: Đĩa cứng là loại thiết bị nào? 

A. Thiết bị vào. B. Thiết bị ra. C. Thiết bị vừa vào vừa ra. D. Thiết bị lưu trữ. 

Câu 72: Trong các Website dưới đây, Website nào là mạng xã hội? 

A. http://www.facebook.com.  B.24h.com.  C. bacgiang.gov.vn D. thanhnien.vn 

Câu 73: Vai trò của thiết bị ra là: 

A. Xử lý thông tin.   B. Đưa thông tin ra ngoài.  

C. Tiếp nhận thông tin vào. D. Truyền thông tin giữa. 

http://www.facebook.com/
file:///D:/toan/ktck1/24h.com
file:///D:/toan/ktck1/bacgiang.gov.vn


Câu 74: Tìm kiếm tuần tự kiểm tra lần lượt từng phần tử theo đúng thứ tự xuất 

hiện trong danh sách. 

A. Đúng 

B. Sai 

C. Không xác định 

D. Khác 

Câu 75: Tìm kiếm nhị phân chỉ áp dụng khi danh sách đã được sắp xếp theo một 

thứ tự nhất định. 

A. Đúng 

B. Sai 

C. Không xác định 

D. Khác 

Câu 76: Trong sắp xếp nổi bọt, mỗi lượt sẽ đưa phần tử lớn nhất nổi dần về cuối 

danh sách. 

A. Đúng 

B. Sai 

C. Không xác định 

D. Khác 

Câu 77: Sắp xếp chọn luôn tìm phần tử nhỏ nhất của đoạn chưa sắp xếp. 

A. Đúng 

B. Sai 

C. Không xác định 

D. Khác 

Câu 78: Tìm kiếm tuần tự sẽ không nhanh nếu phần tử cần tìm nằm ở cuối danh 

sách. 

A. Đúng 

B. Sai 

C. Không xác định 

D. Khác 

Câu 79: Sắp xếp nổi bọt hoạt động bằng cách so sánh và hoán đổi các phần tử đứng 

cạnh nhau. 

A. Đúng 

B. Sai 

C. Không xác định 

D. Khác 

Câu 80:  Dùng sắp xếp chọn  

(selection sort) tăng dần cho dãy:[5, 2, 4, 1]. 

Sau lượt đầu tiên, dãy sẽ trở thành: 

A. [1, 5, 2, 4] 

B. [1, 2, 4, 5] 

C. [2, 4, 1, 5] 

D. [5, 4, 2, 1] 

 

 

 

 

 

 

 

 



 


